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The following changes have been made to DAT/EM products between Release 6.7 and Release 6.8. Please review these 
revisions made to the software and update your software to implement changes. 
 
As always, DAT/EM welcomes comments and suggestions from you, our clients, so please don’t hesitate to contact our 
support department at support@datem.com, or by calling in or faxing us with your requests. 
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Operating Systems and Windows Updates 
Release 6.8 is supported on Windows XP Professional and Windows 7 Ultimate or Professional operating systems. 

Install all critical Microsoft Windows Updates before DAT/EM software installation.  

Microsoft Office 2007 users must install all available Microsoft Office updates before installing DAT/EM version 6.8. 
 

Advance Notice of Windows XP End of Lifecycle, April 2014 
DAT/EM plans to stop support for Windows XP on the same date that Microsoft stops support for it. According to 
http://support.microsoft.com/ph/1173, “The support for Windows XP with Service Pack 3 ends April 8, 2014.” 

Please plan to upgrade any remaining XP workstations to a higher version of Windows before that date. Windows 7 is the 
only upgrade allowed as of version 6.8. Do not use Windows 8, which is not supported. 
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Hardware Locks/Dongles 
Please install Microsoft Updates and Service Packs for your operating system before applying lock reset programs. 
Network licensing should have the same Sentinel driver version on both the server and the local computers running the 
software. 
 
DAT/EM Release Information (Windows Start > All Programs > Datem Software > Release Information) has a new “Set 
License Server” button in the lower left corner of the dialog. This allows you to move the hardware lock to a different 
computer and force a DAT/EM workstation to find the lock if it can’t do so automatically. This is usually used for moving a 
network lock. The user must have administrator privileges to use this button. 

 
Key-in for name or IP address of the computer that holds the hardware lock 

 
 

CAD Versions 
Release 6.8 has interfaces to the following CAD versions. These are both 32- and 64-bit versions unless otherwise noted: 

 AutoCAD: Autodesk 2004, 2005, 2006, 2007, 32-bit 2008, 2009, 2010, 2011, 2012, 2013, and 2014 products. Note that 64-bit 
AutoCAD 2008 is not supported. Install all available service packs. DAT/EM software will install for multiple AutoCAD products 
of different year numbers on the same computer; however, it will not install for multiple same-year versions together. For 
example, it will not install for both 2012 and Map3D 2012. Note that files may be copied manually to activate more same-year 
versions (contact DAT/EM Support for instructions).  
BE ADVISED: Versions 6.6 and higher no longer support AutoCAD 2000-2002 versions. If you use these old versions, please 
upgrade to AutoCAD 2004 or higher. AutoCAD version 2007 or higher is needed in order to use the new AutoCAD MAPEDITOR. 
 

 ArcGIS: ArcMap 9.1, 9.2, 9.3 (service pack 1), 9.3.1(service pack 2), 10.0 (service pack 4), and 10.1 (service pack 1). 
BE ADVISED: DAT/EM has tentative plans to drop support for ArcGIS 9.x versions at the second DAT/EM software release in 
2014. This would be approximately one year from the 6.8 release. Please prepare to upgrade ArcGIS to a 10.x release. 
Contact DAT/EM if you have concerns about upgrading. 

 
 

 MicroStation: DAT/EM software installs for the following versions: MicroStation V8; V8 2004 Edition; XM; V8i Select Series 1 
(1 not recommended), 2, and 3; Bentley Map and Map Enterprise Select Series 1 (1 not recommended), 2, and 3. 
Note for Select Series 1-to-2, 1-3, or 2-4 upgrades: If you upgrade to MicroStation or Bentley Map to a higher Select Series 
number, you must reinstall any DAT/EM software after installing the Select Series upgrade. 
Note for Power GeoPak Select Series 3: DAT/EM Software installs for Power GeoPak SS3, but it does not run well. Power 
GeoPak has timing problems loading other vendor’s applications. For example, when DAT/EM applications are loaded, the 
“Common.ma” file will not load. When DAT/EM applications load automatically, the “GeoPak” menu disappears from the menu 
bar. Therefore DAT/EM version 6.8 should not be installed for Power GeoPak. 
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Video Drivers 
Please note our video driver installation/update recommendations: 

 DO NOT install the driver on media packaged with a video card. It will be too old. 

 1st: Get the latest driver for your video card and operating system from www.nVidia.com. 

 2nd: If the driver on www.nvidia.com does not work, contact support@datem.com for advice. We may ask you to 
download an older driver from either www.nvidia.com or www.datem.com, depending on your hardware. 

 If you need to change (update or back out) a video driver, please follow the instructions at www.datem.com 
Support > Downloads > Manuals > Installation Instructions>“StereoLCDInstallationInstructions.pdf”. This 
shows how to replace drivers and verify that the new drivers have been installed properly. It is very important to 
check on the “Custom” and “Clean” installation choices. 

 On existing workstations, check your video driver periodically. The easiest schedule is to check it before installing 
each DAT/EM software update. If you use a single-panel LCD display and the video driver is older than the one 
currently offered at www.nvidia.com, please update it using the “Custom” and “Clean” installation options. 

Further notes: 

 When checking your installed video driver version, remember that the actual version consists of the last five digits 
with the decimal point moved two spaces to the right. For example, 6.14.12.7642 is really version 276.42. In the 
past, nVidia sometimes omitted a zero (0) from the version; for example, version 6.14.13.732 was really 307.32. 

 To check the installed video driver version on Windows 7, right click anywhere on a blank area of the desktop. 
Select Screen Resolution > Advanced Settings > Adapter tab > Properties > Driver tab > Driver Version. 

 To check the installed video driver version on Windows XP, right click anywhere on a blank area of the desktop. 
Select Properties > Settings tab > Advanced > Adapter tab > Properties > Driver tab > Driver Version. 

 For video settings, see www.datem.com Support > Downloads > Manuals > Installation Instructions. Most 
users will want either “PlanarInstallationInstructions.pdf” for Planar dual-LCD monitors or 
“StereoLCDInstallationInstructions.pdf” for single LCD stereo monitors. 

 
 

Software Installation and File Locations 
The following has changed for DAT/EM software installation or the location where DAT/EM applications store data: 

1. Previously, DAT/EM applications often stored settings and files in the \Program Files\Datem Software or 
\Program Files (x86)\Datem Software folder. Now files that are common to all users or common to all DAT/EM 
applications will be stored in \ProgramData\Datem Systems OR equivalent Windows XP location. Here is a list 
of items than have been moved: 

 Geocalc data files and folder, which includes the elevation database 

 Cursor files 

 Keypad files 

 .reg files 

If your DAT/EM Keypad Controller files used any .bmp graphics from the former location, they may appear as a 
red “X” the first time you open the Keypad overlay. Use Keypad’s Tools>Image Directory to change the paths. 

Files placed in this location will be accessible by all users, so permission will no longer be an issue. Therefore, 
users will not need to have administrator privileges to save or change this data.  

Data can be stored per user. The stereoplotter.mac and Landscape.mac files that store shortcuts will be stored 
in \Users\<username>\AppData\Local\Datem Systems\<application name> (also has hidden attributes). 
Previously, custom shortcuts applied for all users. Now, they will be stored separately for each user. 
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2. There is a new DAT/EM-PCI Runtime ProPack installation to install after installing version 6.8. It allows you to use 
Geomatica 2010-to-2013 projects. Download the file at www.datem.com and install it. It will launch the PCI 
License Utility, which contains a fingerprint and a link to a web request form. Copy the fingerprint and use the link 
to send the fingerprint to PCI. 

 

PCI will send a license file. Rename the file to “lservrc.txt” and copy it to both the 32-bit and 64-bit locations: 

 \Program Files (x86)\Datem Software\ProPack\exe 

 \Program Files\Datem Software\ProPack\EXE 

Run the following files in the 32- and 64-bit locations.  

 \Program Files (x86)\Datem Software\ProPack\exe\licenseutility.exe 

 \Program Files\Datem Software\ProPack\EXE\licenseutility.exe 

Select the “Import” button, and browse for the “lservrc.txt” file in that same folder. Information will appear in the 
license file list below the “Import” button. Close. 

 

Select “Import” and browse for lservrc.txt 

Finally run the following file in the 32- and 64-bit locations: 

 \Program Files (x86)\Datem Software\ProPack\exe\lsinit.exe 

 \Program Files\Datem Software\ProPack\EXE\lsinit.exe 

 
PIX images should now open in Summit. If they do not, please contact DAT/EM Support. 
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64-bit Beta Applications in \Program Files\Datem Software 
 
Anyone is welcome to try the beta 64-bit DAT/EM applications that are 
installed for 64-bit operating systems in the \Program Files\Datem 
Software folder. 
 
Please be aware that these are beta versions and could contain 
previously unreported problems. Please report any issues or 
suggestions to support@datem.com. The 64-bit applications can be 
found in Windows Start > Datem Software > 64 Beta. 
 
Summit .smtxml projects created by the 64-bit Summit may be opened 
later by the 32-bit Summit and vice versa. 
 
Speed improvements for 64-bit applications may be particularly 
noticeable in Ortho+Mosaic processing. 
 
Hint: In cases where the 32-bit Summit runs out of memory while 
importing a very large 3rd-party project (such as Z/I or SocetSet), try 
importing with the 64-bit Summit instead. After the .smtxml is created, 
it may be used with either the 32- or 64-bit version of Summit. 

DAT/EM Keypad 
The following changes have been made to the DAT/EM Keypad products during the 6.8 development cycle: 

1. Version 1.2 of the DAT/EM Keypad Advantage application was posted to the Google Play Store on Dec. 13, 2012. 
This update contains the following: 

a. Allows the keypad diagram on the Android device to use font sizing and font effects such as underline. 
Note that the list of fonts supported by the Android OS is limited; if Android does not find a font, it defaults 
to its Droid font. 

b. If a key is set to “Header” in the Keypad Controller, it shrinks the height on the Android side to 75%. 

c. Displays the Keypad Controller’s “Landscape” (non-Portrait) mode on the Android device correctly. 

2. Version 1.3 of the DAT/EM Keypad Advantage application was posted to the Google Play Store on January 11. 
DAT/EM version builds from this time forward contain an updated Keypad Controller application and Blue Tooth 
driver for Windows XP 32- and 64-bit OS. The DAT/EM Keypad Advantage is now considered to be both 
Windows XP and Windows 7 compatible. A newer installation document has been posted to www.datem.com. 

3. Version 1.4 of the DAT/EM Keypad Advantage application was posted to the Google Play Store on January 31. It 
allows a single key setting to both send a Capture command string and change the keypad overlay. 

4. DAT/EM has some new driver recommendations for the BT 4 Blue Tooth emitter. The BT 4 is like the original 
Medialink emitter, but the chipset is slightly newer and requires a different driver. The Medialink device uses the 
2070 driver and the IOGear device uses the 20702 driver. On Windows 7, the user does not have to do anything 
(the OS installs the correct driver). On Windows XP, the normal XP install procedure is required, but use the 
20702 driver. If you purchase a Blue Tooth device that does not work with any of the Windows 7 automatically 
installed drivers or the Windows XP drivers supplied by DAT/EM, please contact DAT/EM Support. 

5. The DAT/EM Keypad controller will no longer clear your current overlay if you (usually accidentally) select the 
“Paste the current overlay” button without having previously copied an overlay. If there is a copied overlay and the 
current overlay contains any button definitions that will be overwritten, it will prompt to be sure you want to paste. 
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Summit Evolution 
The following changes have been made to Summit Evolution and the applications that are provided with it. 

1. Jpeg2000 (JP2) images are now a very reasonable replacement for Tiff/Jpeg for use in Summit. In the past, 
memory use with very large JP2 files could be a problem. This problem has been vastly reduced by some library 
optimizations and tile size choices. Now we can officially say that JP2 is as good as TIFF for use in Summit. 

Any DAT/EM applications that write JP2 will now automatically choose the optimal tile size that minimizes 
memory use and preserves performance. Tile sizes will range from 512 to 1024. Therefore, Image Creator will 
always generate JP2 files that will be the fastest and use the least memory for DAT/EM applications. For images 
over 2GB, the program automatically increases tile sizes to minimize memory use. 

Just like TIFF, not all JP2 we receive from other sources will work well. For instance, the Pléiades satellite JP2 
files we received use a tile size of 2048; this size results in poorer performance. Like non-tiled Tiffs, users can run 
these through Image Creator and generate optimal JP2 files. 

Reasons to use Jpeg2000: 

 It can compress any number of bands. Tiff/Jpeg can only compress 1 or 3 bands. 

 JP2 can compress 8-16 bits. Tiff only supports compression of 8 or 12 bits. 

 JP2 supports lossless compression. 

 JP2 compression has fewer visual artifacts than Jpeg. Think of this as a higher quality compression. 

 Very useful for 4- or more-band mosaic generation. 

Possible reason not to use Jpeg2000: 

 With DAT/EM software, JP2 should work very well. The problem is that other software may not support it. 
For example, Trimble (Inpho) MATCH-T does not read JP2. If the images will be used in any 3rd-party 
software that does not support JP2, use Image Creator to convert to TIF. 

2. Summit Evolution, Image Creator, and all other image-reading DAT/EM applications now accept BigTiff format. 
Image Creator and Ortho+Mosaic’s mosaic creation also write BigTiff. BigTiff should be a good alternative to JP2 
for those who do not want to apply image compression.  

a. Note that the older-format 32-bit Tiffs are limited to 4 GB, because the internal pointer offsets are 32 bits. 
BigTiff is a special Tiff that breaks through this 32-bit limit and allows almost unlimited image sizes. BigTiff 
can be any size over or under 4 GB. 

b. In DAT/EM’s tests, BigTiff images with zoom levels worked very well and were approximately as fast to 
generate as 32-bit Tif. 

c. The user will be responsible for choosing this format. DAT/EM applications will not automatically attempt 
to convert a Tiff to BigTiff if a file size over 4 GB is detected. If a “normal” Tiff goes above 4GB it will be 
corrupt. 

Advantages of BigTiff: 

o All the benefits of Tiff, plus nearly unlimited size. Will work seamlessly in DAT/EM software just as 
if it were a “normal” Tiff. 

o Can still use JPEG compression. 

o Is faster than JP2, but not by much (assuming nicely tiled BigTiff, of course). 

o Could make unlimited size mosaics without any compression. 

Disadvantages of BigTiff: 

o Like JP2, there are many 3rd-party software packages that do not support it. 

o It uses the TIF filename extension, but a “normal” TIFF reader will not be able to read it. 

o Photoshop cannot currently read BigTiff, although it can read JP2. 
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3. For Jpeg2000 and geoTiff, Summit Evolution’s image information “i” will show the geoTiff metadata if the values 
exist in the file header. This includes coordinate system, datum, and units. 

a. Note: Ortho+Mosaic will write this information if it is found in an input file. 

b. Note: Image Creator will retain and write this information if it is found in an input file, but Image Creator’s 
information “i” will not show the information. This is to ensure that Image Creator can run on a computer 
that does not have the Blue Marble geo database installed. 

 

Coordinate system, datum, and units added to “i” information 

4. Summit > Tools > Options > Export and Import can now save and load a user-supplied filename. Previously, it 
saved under a default filename, which the user did not control. 

5. Summit > Tools > Options > Input Devices tab has a new system mouse options button with the following 
settings available: 

  

a. Leave Pan mode: Right double click or Right single click to stop controlling the cursor in Summit 
using two or one right mouse button clicks. 

b. Reverse zoom direction when using Wheel or Ctrl-Wheel: Reverses the default zoom in and zoom out 
direction for the mouse wheel-activated zoom. Reversing may be useful to match the behavior of the 
mouse wheel zoom in the ArcMap data view, which is opposite to Summit’s default zoom direction. 

c. Pan with Middle button down, release on button up: This allows the system mouse to pan the Summit 
cursor quickly with or without previously activating the mouse control of Summit with a single right click. 
When the middle mouse (wheel) button is pressed down, Summit pans. When it is released, it is always in 
system mouse mode, not controlling the Summit cursor. 
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6. Summit tools and Summit-related applications that have a “pan hand”  on a toolbar can now quickly activate 
panning. Press down and hold the system mouse wheel button to activate panning. Release the button to stop 
panning. Spinning the system mouse wheel zooms in and out as it did before. Affected tools and applications are 
the Status Tracker (now a separate application), Summit’s Tie Point Overview, Image Viewer, and Project 
Viewer/Ortho+Mosaic. 

7. Summit and Ortho+Mosaic 6.8 will now always save .smtxml and .omxml project files with point “.” as decimal 
markers, no matter what the current setting for Tools>Options>Coordinates>Coordinate Format>Standard/ 
European. When reading new 6.8+ projects, the “.” is assumed. New project files will never be saved with a 
comma “,” as a decimal marker. If the project version stored in the .smtxml/.omxml 6.7 or lower, it will 
automatically detect whether commas are in the numeric fields, read the file correctly, and adjust the locale 
appropriately. Therefore, the Coordinate Format setting will no longer affect reading and writing of projects; it will 
only affect on-screen decimal number displays. This change fixes a problem where Summit could not read the 
project’s decimal format when Coordinate Format was currently set to the opposite decimal style. 

8. Sharpening in the video card previously slowed down the panning speed when loading tiles. DAT/EM 
implemented its own new sharpening algorithm and moved it to a different thread so that sharpening no longer 
slows down the video card. 

9. If Summit > Tools > Movement rotation is active, the movement angle is preserved even when Lock X and 
Lock Y are active on the Locking toolbar. In previous versions, locking X or Y would reset the movement rotation 
to zero degrees. 

 

Movement Rotation preserved with X or Y locking 

10. Multiple viewports that have a group open each have a new option to automatically open the next model when 
they leave their own model’s stereo area. This appears as a toggle button on the view’s title bar. The button is 
outlined in blue when on and red when off. Each viewport initially takes the Tools>Options>Project 
tab>”Automatically load next model…” setting. 

 

New automatically load next model toggle in viewports that have a group open (blue=on, red=off) 
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11. Opening a control file by double clicking its file name will no longer open a second instance of Summit if a first 
instance is already running. 

12. The Terrain Following tool has the following changes: 

a. If one or more terrain files were loaded when the project was closed, it will automatically reload the files 
when the project is reopened. Terrain Following mode on/off is automatically reactivated also. 

b. It has a new Auto reload and clip on model change setting that allows the terrain following file(s) to 
automatically load when a model opens. This setting takes effect only if Clip to stereo region is on. It 
works when a model from the project first opens and when Summit automatically loads the next model. 
Previously, the terrain following points would unload when another model opened, and the user had to 
use the dialog to reload the file. 

 

New Auto reload and clip on model change setting 

13. Tools > Measurements has two changes: 

a. Show Polyline draws a temporary graphic polyline to show the coordinates that have been picked. This 
line disappears on Reset. 

b.  (Percent) % Grade display based on the equation: 

(% grade) = [(Z change) ÷ (XY change)]*100 

Note that % Grade only refers to the last segment,  

 

Tools > Measurements > % Grade and Show Polyline 
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14. Status Tracker has been removed from Summit and made into a separate executable. It can still be launched 
from Tools>Status Tracker as before. It may also be launched from \Program Files (x86)\Datem Software\ 
StatusTracker.exe or from Windows Start>All Programs>Datem Software>Status Tracker. The program is 
unlocked so that it can be used on any computer. If you would like a keycode for a stand-alone Status Tracker, 
please send a request to support@datem.com ; a keycode may be included in your update email message. 
Status Tracker also has the following enhancements: 

a. Hours and progress tracking have been added to Status Tracker. 

 

Status Tracker progress coloring example 

 

Status Tracker has an opacity setting for progress coloring 
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When you click on a tile, a small dialog will pop up; it lets you select an editor for the tile. 

 

Select an editor for the tile 

The “Hours” button activates the Hours Editor dialog: 

 

Status Tracker’s Hours Editor 

The bottom of the dialog lets you append new hours information. You can also delete and edit entries using the 
list. To delete, select a row and hit the delete key. This will only delete the hours record and not the associated 
person. You can pick other tiles while the grid is up. 

To add new persons, click the add person button. Note that if you delete a person that it will result in all 
hours records associated with that person to be deleted! 

 

Status Tracker’s Person Editor 

 

You can also view all hours in all tiles using the Project Hours dialog. 



DAT/EM Systems International RELEASE 6.8 Product Notes 

 12

b. Status Tracker has a new CAD file monitoring tool that does the following: 

o Selects CAD files for monitoring (CAD formats are .dxf, .dwg, .dgn. and .shp) 

o Simplifies polylines and reduces points and triangles to create “CAD previews” for display in 
Status Tracker 

o Saves the simplified CAD previews for quick loading and viewing. 

o Detects file modifications and reloads and recreates previews if the file has been modified since 
last preview creation 

To use: 

o Select Status Tracker > Display > CAD File Monitoring. 

o Use Add Files to build a list of files to monitor. 

o Check or uncheck files for display. 

o Select Update to build any necessary CAD previews. 

o Whenever you want to see an updated view, start the dialog and select the update button again. 
Any files that have been modified will reload and new previews will be created. For unmodified 
files, the previously made previews will load (this is very fast). 

For example, a very large AutoCAD file may take one minute to load the first time, because it 
must make a preview. After that, as long as the file stays unmodified, it will seem to load instantly 
as it accesses the existing preview. If the file is modified, there will be another delay while it 
makes a new preview. 

 

Status Tracker’s CAD file monitoring dialog 

The CAD previews are not displayed when first loading a database and are not automatically 
updated. Activate the dialog and select Update when you want see the most current view of the 
CAD files. 
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15. Coordinate system transformation settings have the following fixes and changes:  

a. The Coordinate Conversion for Project dialog is accessed from the  button on the Orientation toolbar. 
This dialog now has new buttons for quickly setting commonly used choices or to reset. 

 Load coordinate system loads the settings saved most recently by the Save 
coordinate system button. 

 Save coordinate system saves the current settings. Use this button after selecting the 
settings for a system that you use often. 

 Set default coordinate system WGS84 clears current settings and resets to WGS84. 

 

 

New  buttons on the Coordinate Conversion dialog 

b. Project Edit dialogs for ADS40/80, VisionMap A3, and RPC satellite imagery no longer have their own 
coordinate system settings. They now have a button that launches the Coordinate Conversion for Project 
dialog shown above. This is the same dialog that is shown for all other project types that allow coordinate 
conversion. Projects that formerly did not allow an input system to be set, such as ADS40/80 and RPC 
satellites now allow the input system, so that different types of WGS84 may be set when necessary: 

16. Aerial projects have the following changes: 

a. Absolute Orientation (AO) was fixed to avoid a problem as follows: Relative Orientation (RO) was not 
applied to the current model properly if the model stayed open after RO and AO started right away. The 
RO could actually save properly; if the model closed and reopened, the RO was correct and the problem 
was avoided. The most obvious symptom was that the images jumped apart when AO was started and 
the cursor moved. 

b. The Summit .smtxml project file now stores the most recently used camera file (or files) in the project as 
an “emergency backup” camera. The externally referenced camera file has priority. If the externally 
referenced camera file is not found, Summit uses the version that is found inside the .smtxml file. The 
camera file or files are stored in the project file every time the project is saved. 

Note: Control files will not be saved internally; they can be too big to write to the project file. 

Note: Camera files are saved internally for aerial and close-range project types only. 

c. Camera files with long lists of distance distortions could cause Summit to crash. This has been fixed. 
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17. Close-range projects have the same ability as aerial project to save the camera information in the project file and 
save long lists of distance distortions in the camera file. This is described in the “Aerial projects” item above. 

18. ADS40/80 projects: have the following changes: 

a. The “Add Multiple” Project Editor button now works for JPEG2000 (JP2) format images. The check for 
duplicate file names of different file extensions order is: SMTI, JP2, TIF. That is, if you have an SMTI and 
JP2 with the same name, it will select the SMTI. If you have a TIF and a JP2, it will select the JP2. 

b. The ADS40/80 Using Leica Kit project type now allows a choice of input systems. Previously, one type of 
WGS84 was set automatically and could not be changed by the user. Customers reported having 
ADS40/80 projects used a newer form of WGS84. The coordinate system settings that used to appear in 
the dialog are now accessed from a Coordinate Systems button, which brings up the same dialog as the 

 button on the Orientation toolbar. 

It is the user’s responsibility to set the correct input and output coordinate systems. 

When you open an already existing ADS40/80 project, check the input and output settings and make sure 
the Apply the coordinate system conversion to the project is checked on. 

  

 

19. Satellite RPC and ALOS-1 projects have the following changes and additions: 

a. In the RPC Project Edit dialog, you can now browse for and select multiple control files at the same time.  

b. The ALOS project type “Add CEOS” button can now find and process an additional set of file names. This 
was to accommodate a customer’s set of files that had slightly different names. Previously, “Add CEOS” 
would not find or add any files to the project for these ALOS files. 

c. In ALOS projects in version 6.7 and lower, there were cases where measured ground control points could 
be mistakenly used as tie points. This happened with latitude-longitude coordinates. This has been fixed. 

d. A readme.txt file now appears in the folder with any DAT/EM-generated RPC projects. This describes the 
projects and how they are named. 

e. The Pleiades TIL tile file will now be created correctly for projects that have 1KB TIF file tiles, which are 
placeholders for blank tiles. 

f. The RPC project type now allows a choice of input systems. Previously, one type of WGS84 was set 
automatically and could not be changed by the user. WGS84 (EPSG: 4326) will still be the input system 
for most RPC projects, but other systems could be set if necessary. The coordinate system settings that 
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used to appear in the dialog are now accessed from a Coordinate Systems button, which brings up the 

same dialog as the  button on the Orientation toolbar. This is consistent with all other project types. 

It is the user’s responsibility to set the correct input and output coordinate systems. 

When you open an already existing RPC project, check the input and output settings and make sure the 
Apply the coordinate system conversion to the project is checked on. 

  

RPC projects now use a full “Coordinate Conversion for Project” dialog. Make sure “Apply the coordinates…” is on. 

 

20. VisionMap A3 projects have a fix to correctly rotate AutoCAD’s tablet so it is not 180º from Summit’s kappa. 

21. Photo Stitch projects now turn on “Auto Next” by default in the Tie Points dialog. 

22. Importing DVP Projects: Summit > File > Import > DVP DAT Files > Exterior in Radians is a new checkbox to 
import the omega, phi, and kappa values in radians instead of degrees. Some older projects may need this setting 
on. The project where DAT/EM found this to be necessary was from 1999. If importing as degrees fails to produce 
good stereo, import the DAT file again with the Exterior in Radians setting on. 

23. Superimposition has the following changes: 

a. A memory issue was fixed. Symptoms included missing vector data from large CAD/GIS files and 
incomplete redraws after model changes. 

b. Some rubber banding issues were fixed for various CAD commands. 
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24. Stereo Mate Generator has the following changes: 

a. There is a fix for SID format file input. Previously, it would write a few lines of correctly colored pixels, but 
the remainder of the file would be all black pixels. 

b. A ½ –pixel shift in the blended pixels was fixed. 

25. Point Translator: An error has been fixed for reading large “SDT DiAP files” .sdt format. Smaller files could be 
read properly, but the application would crash if the file was too large. This fix applies to Point Translator and any 
other DAT/EM application that reads point files, including Landscape, Capture for ArcGIS “Drape” tool, Contour 
Creator, Ortho+Mosaic, etc. 

26. Contour Creator has the following changes: 

a. With Constrain=off and breakline-only input, the resulting contours could have a “curled” or “hooked” 
appearance at the clipping boundary. This has been fixed. 

 

Contour Creator no longer creates curled contours at the clipping boundary 

 

b. The default tolerance values for the collinear test were different if Spline Line was off or on. The value 
with Spline Line off was very small, so that the line vertices were only removed if the segments were very 
close to being collinear. With Spline Line on, the value was much bigger, so that too many vertices could 
be removed. Now they work the same and both use the smaller value. 

 

27. Image Viewer has the following changes: 

a. DAT/EM Image Viewer now allows selection of bands for viewing. The 4th band item under the View 
menu is removed and replaced with a Channel Manager. 

b. Image Viewer is one of several Summit-Related tools and applications that can now quickly activate 

panning using the system mouse wheel. To activate the “pan hand”  panning mode, press down and 
hold the system mouse wheel. Release the wheel button to stop panning. Spinning the system mouse 
wheel zooms in and out as it did before. 
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28. Image Creator has the following changes: 

a. Image Creator v.6.7 had a bug in the Jpeg2000 writer that is now fixed. There was a 25% chance that 
image tiles on the right and bottom could be corrupted, depending on the width and height of the image. 

b. In Image Creator’s advanced options, the Reduce to 8 bit could have trouble if the input image contained 
any pixels with bits that did not match the selected bit number. It would remap the out-of -range bits to 
and undesired color. Now if it encounters bits different than the selected number, it maps the color to the 
highest 8-bit output value of 255. 

c. If a compressed image was smaller than the 4GB TIF image size limit, but its decompressed size would 
be larger than 4GB, Reduce to 8 bit processing would have problems. It would decompress the whole 
file during processing, then have problems associated with exceeding the TIF standard. Now it 
decompresses only part of the file at any one time, thus avoiding going over the 4GB limit. 

d. An error has been fixed for reading large “SDT DiAP files” .sdt format. Smaller files could be read 
properly, but the application would crash if the file was too large. This fix applies to Contour Creator and 
any other DAT/EM application that reads point files, including Landscape, Capture for ArcGIS “Drape” 
tool, Point Translator, Ortho+Mosaic, etc. 

 

29. Project Viewer / Ortho+Mosaic has the following changes: 

a. Orthophoto and mosaic generation will now be much faster while using less memory using newly 
optimized processing methods. 

b. The following additional Summit image adjustments are now supported in Ortho+Mosaic: gamma, 
sharpening, and minimum/maximum threshold. 

c. The state of checked and unchecked images is now saved between runs of the application. 

d. ArcGIS SHP shapefiles now work correctly as orthophoto vector files and mosaic image boundaries. 
Previously, they were ignored or did not offer the “Shapes” and “Breaklines” checkboxes for the layer. 

e. Ortho+Mosaic will open much faster for Summit projects that have many points in the control file(s). 

f. Project Viewer/Ortho+Mosaic is one of several Summit-Related tools and applications that can now 

quickly activate panning using the system mouse wheel. To activate the “pan hand”  panning mode, 
press down and hold the system mouse wheel. Release the wheel button to stop panning. Spinning the 
system mouse wheel zooms in and out as it did before. 

g. An orthophoto boundary generation error has been fixed to prevent “zingers” that have a coordinate such 
as (0,0,0) when a low edge percentage is selected. 

h. An error has been fixed for reading large “SDT DiAP files” .sdt format. Smaller files could be read 
properly, but the application would crash if the file was too large. This fix applies to Ortho+Mosaic and any 
other DAT/EM application that reads point files, including Landscape, Capture for ArcGIS “Drape” tool, 
Point Translator, Contour Creator, etc. 

i. Shapefiles (.shp) with polygon geometry will now load properly as vector input files. 
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j. Ortho+Mosaic and Summit 6.8 will now always save .smtxml and .omxml project files with point “.” as 
decimal markers, no matter what the current setting for Tools>Options>Coordinates>Coordinate 
Format>Standard/European. When reading new 6.8+ projects, the “.” is assumed. New project files will 
never be saved with a comma “,” as a decimal marker. If the project version stored in the 
.smtxml/.omxml 6.7 or lower, it will automatically detect whether commas are in the numeric fields, read 
the file correctly, and adjust the locale appropriately. Therefore, the Coordinate Format setting will no 
longer affect reading and writing of projects; it will only affect on-screen decimal number displays. This 
change fixes a problem where Ortho+Mosaic could not read the project’s decimal format when 
Coordinate Format was set to the opposite decimal marker style. 

k. Unload previews upon processing is a new option in Ortho+Mosaic Tools > Options. This clears the 
image previews out of memory when orthophoto or mosaic generation starts. DAT/EM highly 
recommends keeping this setting checked on, especially if there are many images in the project. 

 

New Unload previews… setting clears the memory used by image previews 

l. Two new settings appear on the Create Mosaic Image tab: Make 8 bit outputs as an 8-bit image for 
higher-bit input; Make 3 Channel outputs only the first three channels for 4-band or higher-band input. 

 

New Make 8 bit and Make 3 Channel settings for mosaic output 

m. Orthophoto generation will now automatically optimize the DEM (point file) formats if necessary. This 
solves the problems of using slow-to-read formats like TXT and also of using very big files with large 
numbers of points. Slow files (such as ASCII files) are converted and large files are automatically tiled. 
The optimal number of points in a file is from 5 to 10 million points. The “optimal” files are stored in the 
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<settings_projectName>\optDEM folder. This optimization is only done once per project unless the 
DEM files are modified. An XML file is used to keep track of any changes. When changes are detected, it 
will re-optimize. For example, TXT files with approximately 1 million points each took around 11 minutes 
to process; after optimization, the generation took about 5.5 minutes, including optimization. Likewise, a 
21-million-point LAS file took 11 minutes before tiling and less than 6 minutes after tiling. “Optimizing 
point files” may sometimes appear at the lower edge of the Generate Orthophotos dialog: 

 

“Optimizing point files” will appear for some point file formats or file sizes 

n. For Jpeg2000 and geoTiff, Ortho+Mosaic can now write geoTiff metadata into the orthophoto or mosaic if 
the values exist in the file header of the input file(s). To make the geo metadata available, the original 
Summit project must have at least an input coordinate system defined. If coordinate system 
transformation is not on in Summit, and the input coordinate system is set to something other than 
“WGS84 (EPSG: 4326)”, then the input system will be written to the orthophoto header. If an output 
coordinate system is defined and coordinate transformation is on in Summit, the output coordinate system 
will be written to the output file. Use Summit’s or Ortho+Mosaic’s “I” information to see the metadata. 

 

Example of Coordinate System, Datum, and Units metadata in an orthophoto header 
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o. Mosaic generation now supports up to 10 image bands. (Previously, it was limited to 4 bands in version 
6.7 and 3 bands in 6.6 and lower.) New features are as follows: 

 Processes up to 10 bands. 

 These bands are supported by all mosaic processing including things like hotspot and balancing. 

 JPEG2000 (JP2) and BigTiff have been added as output format options. (For more information on 
BigTiff, see item 2 on page 6. Information on JP2 appears below.) 

 User interface improvements. 

 DAT/EM Image Viewer now allows selection of bands for viewing. (See item 27.a on page 16.) 

Why did DAT/EM add the JPEG2000 output format? The older TIFF/JPEG solution has limitations. You 
could only compress 3 or fewer bands, which is a limitation of the JPEG compression standard. Additional 
problems were that TIFF files are limited to 4GB and TIFF/JPEG compression is limited to 8 or 12 bits. 

The good things about the new JPEG2000 format are as follows: 

 Compresses any number of bands. 

 Supports 8-to-16 bits. 

 Supports lossless compression. 

 Can make mosaic files over 4GB. 

 Supports embedded zoom levels. 

 Supports geographic information in the form of XML inside the JP2 image. A TFW (Tiff World) file 
can also be output for JP2. 

However, there are also drawbacks to JPEG2000 as follows: 

 Slow reading speed. This is due to the decompression. This is really the main reason that 
prevents JPEG2000 from being a really great format. 

 JPEG2000 is not supported by many vendors, although higher-end software like Adobe® 
Photoshop® does support it. 

  

The Mosaic Main and Image tabs have changed for up to 10-band output and JP2 
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p. Inclusion Areas and Exclusion Areas have been added to mosaic generation. These import vector files 
that contain polygon areas to include in or exclude from mosaic generation.  

 

In the following demonstration (not a real case), building polygon vectors have been imported as inclusion 
areas: 

 

If these same building vectors are imported as exclusion areas, everything outside the buildings is used: 

 

Inclusions are processed first, then exclusions. If an area lies in both an inclusion and an exclusion area, 
it will be excluded. 
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q. There is a new, much improved exact histogram matching algorithm. Briefly, pixels are ordered strictly so 
that every pixel is unique. The uniqueness is accomplished by using averaging kernels around the pixels. 
This algorithm is much more complex and it will take longer to balance images; however, the improved 
results were deemed worth the extra production time. For faster results, try using the beta 64-bit 
Ortho+Mosaic application. 

 

Example: Original images purposefully made to have extreme color differences 

 

Left: V. 6.7 results matched to the bottom image. Right: V.6.8 results. 

 

r. Mosaic seams previously failed for disjointed model areas. They are now calculated correctly: 

 

Seams are calculated correctly for disjointed model areas 
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DAT/EM Scheduler 
The DAT/EM Scheduler now offers Landscape in addition to the existing AutoCAD MapEditor. It offers both the official 6.8 
32-bit and the beta 64-bit beta versions. See more information in the “Landscape” section below. 

Landscape 
The following changes were made to LANDSCAPE: 

1. An error has been fixed for reading large “SDT DiAP files” .sdt format. Smaller files could be read properly, but 
the application would crash if the file was too large. This fix applies to Landscape and any other DAT/EM 
application that reads point files, including Ortho+Mosaic, Capture for ArcGIS “Drape” tool, Point Translator, 
Contour Creator, etc. 

2. An error connecting to Capture for AutoCAD was fixed. 

3. Landscape has a new distance measuring tool similar to the one in Summit Evolution. Select Landscape > Tools 
> Measurements or select Measure from the toolbar. Pick point(s) in Landscape and move the cursor to see the 
various distance, angle, and related calculations for the current point set. To clear the point set, select the Reset 
button. To make units and related settings, select the options button. 

  

  

Landscape’s Measurements display tool and its settings dialog 
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4. Landscape’s Point Edit dialog offers new point filters: 

a. Vegetation Classify 

b. Road Classify 

c. Color Classify 

d. Scan Classify 

e. Rail Classify: This tool requires high resolution data (~> 50 points/m^2). The statistical analysis is run in 
the kernel. Kernel size usually should be set to 1. A higher number such as 5 will run faster, but the 
accuracy will be lower. 

  

Rail line classification in a top view 

 

Example of power line and rail classification 
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f. Power Line Classify: This tool requires high resolution data (~> 50 points/m^2). The statistical analysis 
is run in the kernel. Kernel size usually should be set to 1. A higher number such as 5 will run faster, but 
the accuracy will be lower. 

 

 

Example of power line classification 
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5. Landscape’s LIDAR Point Editor has a new batch file utility. Create batch files to run again later on the current file 
or a list of files. To use, activate “LIDAR Point Edit” and select the “Launch the batch dialog” button on the right: 

 

The Batch Editor dialog will appear and the “+Insert the current filter at the selected position” (“+”)  and “√ Modify 
the existing batch filter” (“√”) buttons will activate on the original Point Edit dialog. 
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 Use the buttons along the top to prepare the .lb “Landscape Batch” batch file. 

 To add a new filter to the batch file list, highlight the filter on the Point Edit dialog and make 
settings. If necessary, highlight (click on) the existing line to appear above the new line in the 
“LiDAR Filters” list. Select the “+” button located on the Point Edit dialog. 

 To edit an existing filter, click on it in the “LiDAR Filters” list. Its current settings will populate the 
fields in the Point Edit dialog. Make changes and select the “√” button on the Point Edit dialog. 

 To sort the filters, drag and drop the lines into the correct positions in the list. Filters will be run in 
the order they appear in the list. 

 To delete a filter, click on it in the “LiDAR Filters” list. Select the “X” button below the list. 

There are three choices to run the batch file: 

 Run now on current project: Uncheck the “Run batch on the following projects” setting. Select the 
green “Run current…” button at the lower center of the Batch Editor dialog to run on the project that is 
currently open in Landscape. 

 Run now on list of projects: Check on “Run batch on the following projects” and browse for projects 
to create a list of .lndscp files. Select the green “Run current…” button at the lower center of the 
Batch Editor dialog to run on the list of projects in the “Enable Target Project” list. Note that the list 
may contain, but is not required to contain the project that is currently open in Landscape. 

 Run later using the DAT/EM Scheduler: Check on “Run batch on the following projects” and 
browse for projects to create a list of .lndscp files; save the .lb file. Select the white “Start the DAT/EM 
Scheduler application” at the lower edge of the Batch Editor dialog. Select “Landscape” in the 
DAT/EM Scheduler’s Task List and select its green “Create a new task” arrow. Click in the fields to 
edit the entries; browse for the .lb Landscape Batch file in the “Configuration File” field. Choose the 
32- or 64-bit version of Landscape, if available. Set a time in the future and check on the “Enable” 
checkbox. Select Apply and OK. The application will run at the scheduled time. Please note that the 
file(s) it runs on are set earlier in the Batch Editor and are contained in the .lb file. 
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DAT/EM Capture for ArcGIS 
Version  6.8 is compatible with ArcGIS 9.1, 9.2, 9.3.1, 10.0, and 10.1 (each with the latest service packs installed) 
 
BE ADVISED: DAT/EM has tentative plans to drop support for ArcGIS 9.x versions at the second DAT/EM software release in 2014. 
Please prepare to upgrade ArcGIS to a 10.x release. Contact DAT/EM if you have concerns about upgrading. 

The following changes were made to DAT/EM Capture for ArcGIS: 

1. There are changes to the behavior of system mouse cursor in Summit and the DAT/EM Cursor setting in ArcMap. 
Automatically turn off DAT/EM cursor is a new setting that automatically turns off the DAT/EM cursor if an 
ArcMap tool is selected and turns it back on when a DAT/EM tool is selected. This may be especially helpful for 
Summit Lite Edition users and anyone else who uses a system mouse as the main Summit input device. 

Automatically turn off DAT/EM cursor enables you to use ArcMap’s drawing and editing tools using Summit’s 
digitizer as the input device. Note that ArcMap’s digitizing tools are prone to mistakes if Summit digitizes a point at 
the same time the ArcMap view pans; if this becomes a problem, set DAT/EM Capture Coordinates Zoom with 
Summit off. Note also that all ArcMap tools use the ArcMap data frame’s pixel coordinate system instead of 
Summit’s subpixel image coordinate system, whether or not Summit is the digitizer. That means coordinates are 
rounded off to the ArcMap view’s pixel size, with more aggressive rounding the more zoomed out the view is. 

 

New “Automatically turn off [toggle] DAT/EM cursor” setting 

 

2. Zoom Summit is a new setting in the DAT/EM Capture Coordinates dialog. When it is checked on, Summit’s 
main view zooms based on zoom changes activated from the ArcMap data frame. When it is off, Summit’s zoom 
does not change when the ArcMap zoom changes. Although they are opposites, both Zoom with Summit and 
Zoom Summit may be on at the same time. 

 

New Zoom Summit setting zooms the Summit view based on zoom changes in the ArcMap view. 

 

3. An error has been fixed for reading large “SDT DiAP files” .sdt format. Smaller files could be read properly, but 
the application would crash if the file was too large. This fix applies to the Capture for ArcGIS “Drape” tool and 
any other DAT/EM application that reads point files, including Landscape, Ortho+Mosaic, Point Translator, 
Contour Creator, etc. 
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4. Two fixes have made it easier to add vertices to the end of an existing polyline: 

a. Snapping to the endpoint of an existing polyline object with the Modify task has been fixed. It is now 
possible to set the task to Modify, activate a DAT/EM drawing tool such as point-to-point, snap to the end 
of an existing polyline, and draw new vertices onto the end of the polyline. 

b. Close Polyline is now active in Modify mode. After adding vertices to the end of a polyline as described 
above  in 3.a., select Close Polyline to draw a segment from the most recently drawn vertex to the first 
vertex of the original polyline. 

 

Turn on snapping for the layer. Set the task to Modify, select a DAT/EM drawing tool, snap to the end of 
the existing polyline, and draw new vertices. (Endpoint snapping has been fixed.) 

 

While drawing vertices in Modify mode, Close Polyline is now available. 

 

After Close Polyline, the endpoints of the polyline are snapped together. 
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Note: The first snap does not need to be on the endpoint; to replace part of the existing end section, snap 
to a segment or another vertex to replace the shorter polyline remainder. Close Polyline is still available. 

 

5. There is a new Snap tab in DAT/EM Capture Options (on the ArcMap side). It offers the following: 

a. Drive stereoplotter following pick, when checked on, moves the stereoplotter cursor to the snap 
location when the snap is accepted. 

b. Snap ring color sets the color of the snap ring that appears in Summit’s main view. (Note that the snap 
line is set separately by Summit>Tools>Options>SI tab>Rubber Banding.) 

c. Snap State exports and imports the checkbox status of the layers in the Classic Snapping Environment 
window. To load the snap state settings from the keypad or digitizer buttons, use the LoadSnapState 
keyword followed by the name of the snap state you would like to restore. 

LoadSnapState <snap state name> 

Example shown below: LoadSnapState MySnapState1 

 

New Snap tab in DAT/EM Capture Options on the ArcMap side (Snap ring color demonstrated) 

 

6. Visit is a new command to drive the stereoplotter to a list of points. Complete instructions appear in the file 
“Product Notes Supplement - VISIT ArcGIS 6.8.pdf”. 
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7. Add Vertex  is a new editing tool that adds a vertex to an existing polyline or polygon using the Summit 
digitizer with DAT/EM Cursor on. Turn on classic snapping for the layer (preferably edge snap). Set the task to 
Modify. Pick anywhere on the existing segment where the vertex will be added; move the stereoplotter cursor to 
the final location of the vertex and pick to place it at that (x,y,z). The keyword to add this command to the DAT/EM 
Keypad or a digitizer button is: AddVertex. 

 

Here, a polygon and a polyline are both missing a vertex. Select Add Vertex. 

 

 

Pick the polygon segment 
that is missing a vertex 

 

Pick the vertex location 
(before the pick is shown) 

  

Pick the polyline segment 
that is missing a vertex 

 

Pick the vertex location 

8. Remove Vertex  is a new editing tool that removes a vertex from an existing polyline or polygon using the 
Summit digitizer with DAT/EM Cursor on. Snapping must be checked on in the Classic Snapping Environment for 
the object’s layer. Either 3D or 2D snap must be on; if it is not on, it will be turned on automatically when you 
select the Remove Vertex tool. To use, set the task to Modify and select the Remove Vertex tool. The keyword 
to add this command to the DAT/EM Keypad or a digitizer button is: DeleteVertex.  

 

Here, a polygon and a polyline have unwanted vertices. Select Remove Vertex and pick a vertex to delete. 

 

Pick another vertex to delete 

 

Pick another vertex to delete 

  

Pick another vertex to delete 

 

Result 
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9. Cut Polygon with Existing Polyline can now cut multiple polygons without having to reselect the polyline. Select 
the polyline first, then select any number of polygons to be cut. To start a new set of cuts on a different polyline, 
select that polyline instead of another polygon; other ways to cancel and restart the prompt are to press the 
Cancel/Reset/Finish button or the <Escape> keyboard key when ArcMap has Windows focus. Note that clearing 
selections in ArcMap will not clear the active polyline. 

       

Cut polygon with existing polyline can cut multiple polygons. 

 

10. The offset tools can now offset polygons and closed polylines and use either geometry type for the offsets. 
Previously, they could only input and output polylines. 

 

Polygon or closed polyline before offset tool 

 

Select the layer in the Create Features window or 
target field. Use Create offset line in ground 
coordinates to pick the offset location 

 

Offset can be either a closed polyline or a polygon, 
depending on the destination layer 

 

Closed polyline or polygon before offset tool 

 

Select Create one or more offset curves and set a 
table of offset definitions. Select either polyline or 
polygon layer destinations in the table. 

 

Offsets can be either closed polylines or polygons or a 
mixture of geometry types 
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11. The SI Drape tool now works on 3D layers as well as 2D layers. If the data already has a Z value, it will be 
replaced by the Drape DTM/DEM surface. 

12. Elevate Layers was fixed as follows: 

a. It operates on a layer that contains one or more space characters in its name. 

b. It now operates properly on layer subtypes. Note that ArcGIS Standard or ArcGIS Advanced are required 
in order to create subtypes. 

13. An .mxd saved in layout view no longer crashes ArcMap when it is reopened (with the DAT/EM .dll currently 
registered). 

14. The Fill Polygons tool could turn on unexpectedly when ArcMap reopened or a new map file was opened. Now it 
keeps its most recent on/off state. 

15. Superimposition was fixed to better handle large amounts of vector data. 

16. Shift Features has the following changes: 

a. Shift Features > Shift Using Stereoplotter > Vertical previously moved an object in an offset fashion 
from the first stereoplotter Z to the second stereoplotter Z. Now it moves the object to the second 
stereoplotter Z regardless of the initial Z. Snap is not required for Shift Using Stereoplotter. For the first 
point, it automatically picks the object at the point on the object that is nearest to the picked XY and uses 
the object’s Z. This allows it to move the object to the exact stereoplotter Z of the second pick. 

b.  It now opens with its most recent settings active. Previously, some settings would always default to on or 
off, regardless of previous settings. 

c. It no longer has a problem with reactivation if it was the last-used command and its icon was still 
highlighted. 

17. The "SetFieldValue layername:fieldname:value" keypad and button function did not work in ArcGIS 10.0 or 
10.1 with previous versions of DAT/EM software. Now it is fixed; however, the layer name and field name values 
are case sensitive. That is, if the layer is called “ThisIsMyLayer” and the field is called “MyFIELD,” the characters 
must be entered as “SetFieldValue ThisIsMyLayer:MyFIELD:525”. By comparison, “setfieldvalue 
thisismylayer:myfield:525” will not work. An ArcGIS function that was not case sensitive in ArcGIS 9.x is now 
case sensitive. Please change your keypad overlays and button functions to be case sensitive. 

18. Airfield3D: Setting an obstacle's FAACODE could corrupt the object in version 6.7. This is fixed. Several other 
changes were implemented. If you use Airfield3D, please contact support@datem.com for update information. 
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DAT/EM Capture and MapEditor for AutoCAD 
Changes apply to: 

32-bit AutoCAD 2004-2014 versions with the latest service packs. 

64-bit AutoCAD 2009-2014 versions with the latest service packs. Note that 64-bit AutoCAD 2008 is not supported. 

BE ADVISED: DAT/EM Capture no longer supports AutoCAD 2000-2002 versions. If you use these old AutoCAD versions, please 
upgrade to AutoCAD 2004 or higher before installing DAT/EM version 6.8. 

DAT/EM software will install for multiple AutoCAD products of different year numbers on the same computer; however, it will not 
install for multiple same-year versions together. For example, it will install for AutoCAD 2011 and AutoCAD Map3D 2012 together, 
but it will not install for both AutoCAD 2012 and AutoCAD Map3D 2012. Please note that files may be copied manually to activate 
more same-year versions (contact DAT/EM Support for instructions). 

Autodesk Infrastructure Design Suite installs three same-year AutoCAD versions (AutoCAD, Map3D, and Civil3D). You must run 
each version and register/”accept” each one before installing DAT/EM software whether or not you intend to run every version with 
DAT/EM Capture active. DAT/EM software will install completely for only one of them. After that, the user can manually copy the 
AutoCAD \datem folder and the wintab driver file into the other two versions of AutoCAD. Contact DAT/EM Support for instructions. 

Reminder: Install all available AutoCAD service packs and updates before installing DAT/EM software. 

Reminder: After every new AutoCAD installation, you must run AutoCAD at least one time to activate its license before installing 
DAT/EM software. This applies to every version of AutoCAD on the computer whether or not you intend to use every version with 
DAT/EM Capture. 

The following changes were made to DAT/EM Capture and MapEditor for AutoCAD: 

1. Version 6.8 is the first version to install for AutoCAD 2014. 

2. There is a new snap line indicator in Summit’s superimposition. With Osnap or AdvOsnap (DAT/EM Advanced 
Osnap layers) on, when the Summit cursor approaches a snappable object, a superimposed line will indicate the 
potential 2D or 3D snap. Snapping will work with all AutoCAD tools in Summit now. Snapping control is via the 
AutoCAD snap options. 

Hint: Users who have a 3D digitizing device with several buttons may want to add a series of Osnap 
settings to a button. Use Summit’s Button Manager. For example: 

Type=UserCAD, Action='-osnap off{RET}:'-osnap end{RET}:'-osnap near{RET} 

Press the button multiple times to scroll through the Osnap modes. The ‘- allows you to enter these 
commands transparently and without the dialog, so you can change the Osnap mode without interrupting 
the digitizing command. The new snap line will make it easy to see which type of Osnap is active. 

 

3. AutoCAD’s SuperImposition has the following updates: 

a. Some existing SuperImposition rubber banding issues were corrected to work with the new snap 
indication line. 

b. There were fixes for superimposition problems that happened when the Summit model changed 
automatically during an AutoCAD polyline drawing command. 

c. The results of AutoCAD’s TRIM and EXTEND commands now update automatically in Summit’s 
superimposition. 

4. ADVOSNAPS (Advanced OSnaps) was improved for use with AutoCAD 2009 and 2010 and added to AutoCAD 
2013 and 2014. 

5. CAPT2D and CAPT3D now accept “_CLOSE” to close the polyline. This command is issued from “Close” on 

Summit’s CAD toolbar, . Previously, the underscore character, _, prevented “_CLOSE” from working in 
CAPT2D/3D. Note that the underscore worked with AutoCAD’s own commands, such as 3DPOLY, in English and 
international versions of AutoCAD. 



DAT/EM Systems International RELEASE 6.8 Product Notes 

 35

6. DATEMSNAP is a command to make the Summit Evolution cursor move to accepted snap points during certain 
command such as 3DPOLY and CAPT2D/3D with Osnap on. DATEMSNAP was not functional for many years. 
The command has been revived and updated to work with all supported versions of AutoCAD. In addition, 
DATEMSNAP has replaced a misnamed entries on the “DATEM” pull-down menu and ribbon toolbar: 

 

DATEMSNAP On/Off on “DATEM” ribbon toolbar 

 

7. AUTOLIST was not working in version 6.7. It is fixed in 6.8 for all supported AutoCAD versions. 

8. AUTOARC2D/3D, CAPT2D/3D, DATDRAW, and EDITLINE have a new “Trace” mode. “Trace” allows the polyline 
to draw along and match the vertices of another polyline. To use Trace from any of the commands that offer 
“Trace” in their command line menu: 

a. Enter “t” for trace. 

b. Pick the first point and last point to trace along another polyline. 

c. If the other polyline is closed, pick a third point along the path of the trace. This prevents the trace from 
going around the closed polyline on the wrong side. 

For example, trace is offered for EDITLINE’s end, inner and join modes.  

 

 

Two polylines before EDITLINE Trace mode 
 

Activate EDITLINE, choose Trace, and select the 
first trace point on the other polyline. 

 

Select the end of the trace. If the other polyline is 
closed, select a point along the traced section to 
indicate which side to trace. Continue with EditLine. 

 

The two polylines now match vertex to vertex along 
the traced section. 

 

9. LC and LCF commands are fixed to avoid an AutoCAD problem that inserts a blank text style. This caused LC 
and LCF to place text as the previous text style (alphabetically) to the selected style. 
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10. MapEditor for AutoCAD has the following changes: 

a. FILTER has a new “Remove duplicate vertices only” setting. This setting searches for and removes 
duplicate consecutive vertices in a polyline. 

 

New Filter “Remove duplicate vertices only” setting 

b. TOUCH has fixes to prevent overshooting the “to” polyline and other miscellaneous problems with some 
special cases. 

c. TOUCH has several fixes that mostly affect interactions with arcs. 

 

DAT/EM Capture and MapEditor for MicroStation 
Changes apply to Capture for MicroStation. DAT/EM software installs for the following MicroStation versions on 32-bit and 64-
bit operating systems: 

 MicroStation V8 and V8 2004 Edition: Version should be 08.05.00.34 or higher. 

 MicroStation XM: Version should be 08.09.04.88 or higher. 

 MicroStation V8i, V8i-based Bentley Map and Map Enterprise Select Series 1 (1 not recommended), 2, and 3 

If you upgrade from Select Series 1 to 2 or 3, you must reinstall DAT/EM software after installing the Series upgrade.  

DAT/EM will install for all versions of MicroStation that are present on the computer at the time of the DAT/EM installation. 

 
Note about Power GeoPak Select Series 3: DAT/EM Software installs for Power GeoPak SS3, but it does not run well. 
Power GeoPak has widespread timing problems loading other vendor’s applications. For example, when DAT/EM applications 
are loaded, the “Common.ma” file will not load. When DAT/EM applications load automatically, the “GeoPak” menu disappears 
from the menu bar. Therefore DAT/EM version 6.8 should not be installed for Power GeoPak. 

The following changes were made to DAT/EM Capture and MapEditor for MicroStation: 

1. Capture initialization and synchronization are now about twice as fast for version 6.8 than they were in 6.7. 

2. The tentative point marker and tentative text refresh and draw better on both the Summit superimposition and 
MicroStation sides. Tentative marker timing was improved. 

3. A rare startup crash was fixed. It was due to the timing of loading the DAT/EM applications. 

4. The precision o f the Selection Set Editor’s “Fence to Set” selection tool has been improved. 

5. The Selection Sets Editor will no longer allow mesh elements to be added to a set. There are no MapEditor 
commands that process mesh elements. 
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6. MapEditor .PAR parameter files have the following software fixes: 
 CLIP “VIEWOPT” setting is now ignored (instead of being rejected). Only top view (XY) clipping is 

supported. 

 Commands related to text handling, such as MECHANGETEXT and XYZOUT, no longer fail on 
MicroStation’s “Enter Data” text elements. 

 If ZCHECK was selected to add to a parameter file in the Parameter File Editor, the “MEXPORT” dialog 
would launch instead of “ZCheck”. The correct dialog now launches. 

7. A problem was fixed in AUTOARC, FACESHIFT, PSQR, DATDRAW, and TOUCH. They could crash after 
opening a new design file in the same MicroStation session. 

8. Our customers have found some MicroStation files that contain shapes that have a 1-UOR (unit of resolution) gap 
between the first and last point. It is unknown how these shapes were created. DAT/EM altered the following 
commands to accommodate these not-quite-snapped-endpoint shapes: DTM CALCULATE, DTM SELECT, and 
MECLOSE. In addition, EZEDIT and all MapEditor shape commands will fix such shapes by either adding a 
vertex or moving the end vertex, depending on how close the first and last vertices already are. 

9. 3DOFFSET has a new checkbox setting called Preserve complex. The keyins to control this checkbox are 
3DOFFSET PCOMPLEXOFF and 3DOFFSET PCOMPLEXON. 

 (3DOFFSET PCOMPLEX OFF) When Preserve complex is not checked, 3DOFFSET works exactly as it 
did in previous versions. Arcs are offset as series of stroked, short line segments. 

 (3DOFFSET PCOMPLEX ON) When Preserve Complex is checked, complex elements are 
reconstructed to match the original in a final added step. The new element will have the same 
construction as the original, with the same sub-elements and same number of vertices. A projection of 
each vertex and sub-element of the original element is created 

 

 

In the following examples, the original element is depicted in blue, the 3DOFFSET (stroked) element in white 
and the new 3DOFFSET (Preserved) element in red. A caveat is that the projection is made during post 
processing and some of the problems with the current algorithm (e.g. not handling self-crossing elements) are 
still there. 
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3DOFFSET’s Preserve Complex setting on (above) and off (below) 
 

10. BKTRACK has new monotonicity settings similar to the ones in DATDRAW. To activate, check on Z Sequence 
and choose a setting: 

 Increase: The point is added to the line string only if it is higher in elevation than the previous point. 

 Decrease: The point is added to the line string only if it is lower in elevation than the previous point. 

Associated key-ins are: 

 BKTRACK ZSEQUENCE INCREASE – Turns on monotonicity checks and ensures digitized stream is 
moving up in elevation. 

 BKTRACK ZSEQUENCE DECREASE – Turns on monotonicity checks and ensures digitized stream is 
moving down in elevation. 

 BKTRACK ZSEQUENCE OFF – Turns off BKTRACK monotonicity checking. 

 

New BKTRACK settings 

 

11. CELLMARK is a new family of commands to place cells on other elements. CELLMARK can be configured and 
run with a series of keyins or through a dialog. The command allows the user the place the currently active cell at 
the start vertex, end vertex or middle (XY midpoint) of select linear elements (lines, line strings, shapes, complex 
strings, or complex shapes). Cells will be oriented to the angle of the labeled element (at the point at which it is 
placed). 

 CELLMARK – Opens the CellMark dialog. 

 CELLMARK START – Sets the CellMark placement so cells will be placed at the starting vertex of 
selected elements. 

 CELLMARK MIDDLE – Sets the CellMark placement so cells will be placed at the XY midpoint of 
selected elements. 
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 CELLMARK END – Sets the CellMark placement so cells will be placed at the ending vertex of selected 
elements. 

 CELLMARK SET <setname> – Runs CellMark as a keyin using <setname> to determine the elements to 
label, placing the currently active cell and using the most recent CellMark settings. 

 CELLMARK SHARED – Sets the CellMark shared cell setting so shared cells will be placed when 
CellMark is run. 

 CELLMARK NONSHARED – Clears the CellMark shared cell setting so regular cells (non-shared) will be 
placed when CellMark is run. 

 CELLMARK SCALE <cell scale size - decimal> – Sets the CellMark cell scale (size). 

Using the dialog, elements can individually for CELLMARK cell placement, identified by class (symbology and 
level), or identified by a selection set. Using the keyin (CELLMARK SET <setname>) only placement by selection 
set is available. 

The location of placement is set by one of the keyins (CELLMARK START, CELLMARK Middle or CELLMARK 
END) or in the dialog. 

 

The user can choose to place shared cells or regular cells with keyins (CELLMARK SHARED or CELLMARK 
NONSHARED) or with the dialog checkbox (Place Shared Cells – checked places shared cells, unchecked places 
regular cells). 

 

The size of the cell is determined by the active MicroStation true scale setting and the CELLMARK setting (keyin 
CELLMARK SCALE <cell scale size - decimal> or Cell Scale in the dialog). 
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12. CHANGE ATTRIBUTES INTERIOR can now process complex elements containing arcs as boundaries. While it 
might have worked for the first complex boundary, subsequent boundary processing could have added 
deleted/clipped/broken elements back into the file. Note: Boundaries that contain arcs are very slow to process 
and are not recommended; Stroke Element may be used to drop complex on such elements. 

13. CHECK ATTRIBUTES INTERIOR can now properly process arcs in boundaries. 

14. “Close using Last Settings” MELCLOSE is now working. It runs MECLOSE using the most recent settings. It was 
previously documented, but never fully implemented. 

15. CROSSCHECK has the following improvements: 

 It now preserves the direction (order) of string vertices. Previously, it could reverse the direction. 

 There are performance improvements to make it run faster. 

16. CULVERT has two new keyins, CULVERT MIDLINEON and CULVERT MIDLINEOFF. Previously, the midline 
(the line between the culvert endpoints) was always placed. Now the midline is optional. 

 CULVERT MIDLINEON: This is the default. Place the midline with the cells.  

 CULVERT MIDLINEOFF: Place cells only without the midline. 

17. DATDRAW UNDO had a superimposition (SI) redraw issue where the original, retained 
portion of the line string was missing from Summit’s SI. It would reappear in SI when the element was finished. 
This has been fixed. 

18. DTM SAMPLE and DTM CALCULATE no longer fail on shapes that have endpoints that are not quite snapped. 
DAT/EM received .dgn files with shapes that had a one unit of resolution gap between the endpoints. (It is 
unknown how these shapes were created.) 

19. FILTER (MEFILTER) has a new setting that removes duplicate vertices. 

 

 

New “Remove Duplicate Vertices Only” 
setting in MEFILTER 

  

Example: Duplicate vertices 3, 4, and 10 are removed. 
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20. LD CP FILE (“Load Control File”) has the following changes: 

 It is fixed to properly clear previous control points between multiple runs that load different files. 

 It runs much faster on large control files. 

 Multiple selections are now allowed: 

  

  

LD CP FILE multiple selections 

 A sort button has been added. It applies to both the “Available Points” and “Selected Control Points” lists. 

 

The sort is instant, applies to both lists in the same way, and toggles back and forth between ascending 
and descending sorts. 
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LD CP FILE sort option 

21. PSQR has increased error checking. It had crashing issues that are now fixed. 

22. REPLACE OBJECT (MEREPLACEOBJECT) has some added error handling. 

23. ROAD has the following changes: 

 Increased memory and error handling. Previously, it could crash on some input objects, especially short 
line strings. 

 Fixed rubber band so that it extends from the most recent vertex instead of the first vertex. 

24. SHEETCUTTER is a new tool to cut map sheets. Complete instructions appear in the file “Product Notes 
Supplement – SHEETCUTTER 6.8.pdf”. 

25. VISIT has many changes and improvements. 

 VISIT <filename> allows the user to drive to coordinates in a design. 

 VISIT DESIGNS allows the user to quickly step through design files in a directory. 

 VISIT ELEMENT allows the user to drive to elements by class or selection set. Commands, such as 
ZCHECK, JOINIT, BMARK, CROSSCHECK, SLOPECHECK offer users the option to VISIT points of 
interest based on error checks, edits or candidate edits. 

Complete VISIT instructions appear in the file “Product Notes Supplement - VISIT MicroStation 6.8.pdf”. 

 

26. XYZIN can now place objects on the level found in the “Level” field in the defined file format. If “Level” is specified 
in the format, it will override any level setting above in the dialog and use the level from the file. 

27. ZCHECK has the following changes: 

 ZCHECK has performance improvements and runs significantly faster now. 

 If it was selected to add to a parameter file in the Parameter File Editor, the “MEXPORT” dialog would 
launch instead of “ZCheck”. The correct dialog now launches. 

 The “run forward” and “run backward” buttons have been swapped to have “run forward” on the right. 

 There are new sort options to sort the columns as ascending or descending. 

 If Summit is running, it can drive Summit to the coordinates in its list of elevation errors. 
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28. VOLUME (MEVOLUME) has the following changes: 

 Inside Fence: The interactive version of MEVOLUME now allows the user to restrict volume calculation 
to a geographical area defined within an active fence. To use this feature 

i. Running in a top view is very important! Set the active view to the top view (XY plane). 

keyin: VIEW TOP <pick view> 

ii. Place a fence around the area for the calculation. 

iii. Run MEVOLUME. 

iv. Check the Inside Fence check box. 

v. Set the desired configuration for MEVOLUME calculation and output. 
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 Text Options>Pre-Defined Label: The new Pre-Defined Label option places text in a level, volume, 
units format. 

 

Example of the new Pre-Defined Label (<level><volume><units>) format: 
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